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	K-12 Quick Start
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What is ArcView 9.x?

ArcView 9.x includes all the tools and functionalities of ArcView 3.x plus more added features. These include Windows based applications with familiar windows based commands such as undo, cut and paste. Now built in are right click pop up menus and more point and click functionality. There is a catalogue for browsing and managing data, new editing tools; enhanced cartography. There is better label management including support for annotation, and much more.

ArcView 9.x includes a suite of integrated desktop applications: ArcMap, ArcCatalog, and ArcToolbox. 

· ArcMap allows the user to edit, query, analyze, create, and visualize data. It expands on the familiar concepts and interfaces of ArcView 3.x. ArcMap saves maps as map documents rather than projects. These map documents store graphs, tables, geographic data view, and other map features as elements of the map rather than separate components of a project.

· ArcCatalog allows the user to browse, organize, and preview geographic and tabular data as well as create metadata. 

· ArcToolbox provides basic data conversion tools.

In ArcView 9.x, themes have been replaced by layers. They essentially serve the same purpose, however, the advantage of using layers lies in the layers’ ability to exist independent of a data frame or a map layout. Tables and charts are similar to tables and graphs in but with enhanced appearance, and increased functionality and editing capabilities.

ArcMap, ArcCatalog and ArcToolbox are designed to work together to provide a rich and extensible suite of Geographic Information System (GIS) capabilities that enable you to perform any GIS task. For example, you can search for and find a map document in ArcCatalog, then open it in ArcMap by simply double clicking it.  You can then edit and enhance your data through the tools available in the ArcMap environment.

You can also use ArcCatalog to search for data in another location. Once you have found the data that you are interested in you can drag and drop it as a layer in ArcMap. You can also drag and drop from ArcCatalog to ArcToolbox. 
Extension Exercises

Students are not expected to complete the Extension Exercises provided in this lesson. These exercises are intended to provide students with extra tips and extended knowledge of the software.
Starting ArcMap…
Before you begin, go to Remote Desktop> ArcMap will launch. Go to OPEN existing project, navigate to the Arcview Data folder in the C:Drive! Follow your teacher’s link. 
How you start ArcMap depends on the operating system, and where ArcMap was installed.  If you know how to start ArcMap, start it now. If you don’t know how to start ArcMap on your current machine, try going to The Start Menu> Programs> ArcGIS> ArcMap or ask the instructor.

When ArcMap starts up, you will see a dialog box like this:

	[image: image2.emf]


	1. An ArcMap window will appear, with a boxed section asking “Start using ArcMap with”. Select An existing map and make sure that “Browse for maps” is highlighted below. Then click on OK.



	[image: image3.emf]


	2. In the dialog box that comes up, go to the k12quick9 folder (it should be located on your H: drive) and select PartA, and then click [image: image4.png]Open




.

If you cannot locate the K12quick9 folder, ask your instructor for help!




	Throughout this exercise, when you see the [image: image5.png]


 Save It Now Icon, you should save your map. Just click on the Save Map button [image: image6.png]


.  This button is located on a toolbar at the top of your map.

If you are unsure of where to save your map on your current machine, ask the instructor.




Part A – Getting to know ArcMap

	Purpose:

You are going to familiarize yourself with some of the tools ArcMap uses to control your map display.

Geographic Question:

What are the populations of some cities in Atlantic Canada?
	New GIS Skills:
· Turning Layers On and Off

· Changing Layer Draw Order

· Panning / Zooming

· Using the Identify Tool


You should now see the ArcMap window open, as it is below. 

The ArcMap window has several components:
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Turning Layers On and Off

1. Turn the Visibility for the Cities layer off by un-checking the box next to the layer name. Turn off the Canada layer, too. 

2. ( Check both layers to make them visible again.

Changing Draw Order

	3. With both layers visible, click and hold the mouse down on the cities layer. Drag the entire layer down in the Table of Contents (TOC), like this:


Now, the cities will not be visible on the map.  This is because you have moved the cities layer to the bottom of the TOC.  ArcMap draws layers from bottom to top in the TOC, so now the Canada layer is drawn over top of the cities, covering them up. 
	[image: image8.png]= £ Part A- Getting to Know ArcMap
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	4. Move cities back to the top of the TOC. Click and hold the mouse down on the cities layer. Drag the entire layer up in the TOC, like this: 

The general rule of thumb for placement order in the TOC is “points, lines, polygons” for optimal viewing: points over lines, over polygons.
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	One advantage of having a map on the computer screen, rather than on paper is that the extent of the map can be easily changed at any time.

5. Select the Zoom In tool [image: image14.png]


 from the toolbar.  Using your mouse, click and hold the mouse button to drag a rectangle around Eastern and Atlantic Canada.  When you release the mouse, the display will update. If you make a mistake, click Go to Back to Previous Extent [image: image15.emf]

 to undo the zoom and start again.
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Panning and Zooming 

	Buttons for Changing the Map Extent of the View

When you click on a button, the change is visible on the view window right away.

[image: image17.png]


 Zoom to Full Extent button. Zooms to the full extent of all the layers in the Data Frame.  For example, if you’ve zoomed in a couple of times on your map, you can click this button if you want to see the whole map again.
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 Fixed Zoom Out button.  Zooms out once from the centre of the view.

[image: image19.png]


 Fixed Zoom In button.  Zooms in once on the centre of the view.

[image: image20.emf]

 Go Back to Previous Extent button.  Goes back to the previous spatial extent you were viewing.  Click this button to go back to where you were before you zoomed or panned.  You can use this option to retrace several of your steps.

[image: image21.emf]

Go to Next Extent button.  Goes forward to the next spatial extent you were viewing.  Click this button to go back to where you were before you used the previous extent button.

Tools for Navigating Around a Map

When you select a tool and move the cursor over the map, the cursor changes shape to reflect the tool you selected.  The tool remains selected until you choose a different one.  

[image: image22.png]


 Zoom In tool.  To zoom in centred on a particular area on the view, click that position once with this tool.  To zoom in to a particular area on the map, drag a box around the area with this tool.

[image: image23.png]


 Zoom Out tool.  Same as the Zoom In tool but zooms out from the position you click or the area you drag over.

[image: image24.png]


 Pan tool.  Lets you pan the map by dragging the display in any direction with the mouse.  To pan, click this tool, move the cursor anywhere over the view, hold down the mouse button, and drag in any direction.  Release the mouse button to leave the view in your desired position.




Using the Identify Tool
The primary role of all GIS software is to maintain a link between the location information (the map features) and the attribute information (the database).  So far, you have only seen the map features.  ArcMap provides a very quick and easy tool to look at the attribute database.

6. Select the Identify tool [image: image25.png]


  from the Tools toolbar. A window called Identify will appear. Using the pointer, click once on Toronto on the map.  If you do not click directly on a city, you will see different information appear in the Identify window (in fact, you will see information about the polygons that make up Canada).
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7. Experiment! Click on other cities across Canada using the Identify tool. Click on Newfoundland using the Identify tool.  Notice that there is different information stored for the polygons that make up Canada then for the points that represent the cities.  


Notice in the Identify window that you can choose the layer that you wish to obtain information about.  ArcView will automatically default to the <Topmost layer>.  You can choose layers from the drop down list and then use the Identify tool to see information about only that layer.

8. Explore the population of the cities in Atlantic Canada. When you have finished exploring, close the Identify window by single-clicking the Window Close button[image: image27.png]


.
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 Save It Now
[image: image29.png]


 What are the populations of some cities in Atlantic Canada?



Halifax?



Charlottetown?



St. John’s?
Congratulations! You have completed Part A of the K-12 Quick Start lesson!
Extension Exercise – Changing your Layer Symbology

Click on the symbol [image: image30.png]


just below the cities layer in the TOC to bring up the Symbol Selector window. Select a new symbol and click OK.

Now you will symbolize each Canadian province and territory with a unique colour. Double-click on the Canada layer to open the Layer Properties window. Click on the Symbology tab. In the Show section, select Categories and make sure the Unique values is highlighted. Under Field Name, choose NAME, and under Color Ramp choose a set of colours you like.

Click the [image: image31.png]Add All Values



 button to add the provinces and uncheck the <all other values> box, and then click OK.
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You should now see the changes reflected on your map. 

Part C – Earthquakes in Canada

	Purpose:

You are going to investigate what major cities in Canada are near areas of active earthquake activity.

Geographic Question:

How many people live in cities within 350km of the site of a recent earthquake of magnitude 4 or greater?
	New GIS Skills:

· Setting Map Properties

· Setting Layer Properties

· Creating a Thematic Map

· Performing a Spatial Query

· Calculating Statistics


1. From the File menu select Open. Go to the k12quick9 folder and select PartC. Click [image: image33.png]Open




.

	This Map contains four layers:

· cities – Major cities in Canada

· quakes_2006  – Earthquakes in Canada for 2006

· faults – Major tectonic fault lines in Canada

· Canada – Canadian Provinces 
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Setting Data Frame Properties

This view of Canada may not look familiar. This is because the map is not projected, that it is, in ‘raw’ latitude and longitude. To improve the look, we are going to apply a coordinate system, or projection to it.

	2. From the View menu, choose Data Frame Properties. This opens the Data Frame Properties window. 

Click on the Coordinate System tab, open the Predefined folder, then the Projected Coordinate Systems folder, next the Continental folder, then the North America folder and select Canada Lambert Conformal Conic. Click OK. 

A warning may appear about changing the projection, if so, click Yes. ArcMap will redraw the view of Canada using a Lambert Conformal Conic projection. 

Click the Full Extent button [image: image35.png]


 on the toolbar so that you can have a larger view of the map.
	[image: image36.emf]




Setting Layer Properties

	3. Make quakes_2006 visible. This layer shows all earthquakes with a magnitude of 2.0 or greater. You are only interested in quakes with a magnitude of 4.0 or greater, so you’re going to have ArcMap display only quakes that meet that criteria (“Magnitude” >=4).
	[image: image37.jpg]
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	4. Right click quakes_2006 in the TOC. Click Properties opening the Layer Properties window. Next, click on the Definition Query tab.


	5. Click Query Builder, this will open the Query Builder window. You’ll use this to build criteria for your earthquakes:

· First, double-click on [Magnitude] in the list.

· Next, single-click on the [image: image39.bmp] button.

· Then, type the number 4 after the >=.

· Make sure your query builder looks like this:  "MAGNITUDE" >=4
· Click Verify to make sure the expression is correct. Click OK after it has been verified.
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	Tip: For the Query Builder, the Fields and Unique Simple Values lists and the Operation buttons are short cuts.  If you prefer, you can simply type the equation in using your keyboard.
	


	6. Your query should now be in the Definition Query window, if it is correct click OK, if not, go back to the Query Builder and fix it.

ArcMap will redraw the map.  
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ArcMap is now only showing those quakes with a magnitude of 4.0 or greater.
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	By default a layer represents all the features of a particular feature class in the data source it is based on. However it is useful to be able to restrict a layer to represent only a subset of the features in a particular feature class.

For example, you might have a data source that contains arcs for all the roads in your study area, but you want to create a layer that only represents the major highways. In this case you would set its layer properties to define a feature selection consisting of the major highways.


Since quakes_2006 is no longer showing all of the earthquakes, it should be renamed appropriately. 
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	7. Open the layer properties for quakes_2006, by right clicking on it in the TOC and choosing Properties.




	[image: image44.emf]


	8. In the Layer Properties window, select the General tab and change the name of the layer to something that is more meaningful such as Earthquakes >= 4.0.

Click OK.


[image: image45.png]


 Save It Now

Creating a Thematic Map

	9. Open the Layer Properties for Canada by right clicking on it in the TOC and selecting Properties.
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	10. Select the Symbology tab. From here you can change how the layer is displayed in the view. 

11. In the Show window, click Quantities and then Graduated Colors. Pick your map colour from the Color Ramp. Change Value to POP_2006 and click OK.


The map will now have colors representing the populations of each of the provinces.
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Performing a Spatial Query

12. Examine your map.  Canada’s provinces should be shaded by population, with points for all the 2006 earthquakes that had a magnitude of 4 or more. Make the cities layer visible [image: image49.png]


. This layer shows the major cities in Canada.

13. Use the [image: image50.png]


 Identify tool and click on various cities. Notice that one attribute you have for cities is the population. Close the Identify window.

You will now ask ArcMap to select those cities that fall within 350km of a recent earthquake with a magnitude of 4 or above.

	ArcMap provides the ability to select the features of one or more layers using the features of another layer. Selecting features in this way is one of the spatial analysis methods you can use to resolve problems that involve issues of proximity, adjacency, and containment.  ArcMap provides several spatial relation types or predicates to qualify the selection that you make in the Select By Location dialog box. Some commonly used spatial relation types include: 

Are Completely Within – selects features in the target layer if they fall completely within one or more of the selector layer’s features.

Completely Contain – selects features in the target layer that completely contain one or more of the selector layer's features

Have their Center In – selects features in the target layer if their centre falls inside the selector layer's features.

Contain the Center Of – selects features in the target layer that contain the centre of one or more of the selector layer's features

Intersect – selects features in the target layer that intersect the features in the selection layer. Intersection implies that at least one point is common to both the selector and the target or one of them is completely within the other. If the selector and target are the same, Intersect will select adjacent features.

Are Within Distance Of – selects features in the target layer that are within a specified distance of the selector layer's features. 


	14. From the Selection menu, choose Select by Location. This will open the Select by Location window.
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	15. Below the words I want to, there is a drop down list. Choose select features from.
16. Below the words the following layer(s): all of the layers are listed with check boxes beside them. Check cities.

17. Below the word that, there is a second drop down list. From here choose are within a distance of.

18. Below the words the features in this layer, there is a third drop down list. From here, choose Earthquakes >= 4.0.

19. Lastly, beside the word of, change the first box to 350 and the second box to kilometers.

20. Click Apply.

21. Click Close.


When you return to the map, you’ll notice that some of the cities have now been highlighted.  These selected cities are those that fall within 350km of earthquakes that have a magnitude of 4.0 and greater.
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Calculating Statistics

22. Right click cities in the TOC and choose Open Attribute Table.

23. ArcMap will open a document that looks like a spreadsheet. This is called an Attribute Table.
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The records (rows) highlighted in blue correspond to the cities that are highlighted on the map.

24. Click on the [image: image55.png]Selected



 box to see all the highlighted records.
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How many cities fall within 350 km of earthquakes that have a magnitude of 4.0 and greater?
	25. From your table, right click on the grey field title Pop_2006 and choose Statistics. ArcMap will calculate a set of statistical values for in the population field you may have to scroll to the right in your table.
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Note: You can see that there are other statistics and a Frequency Distribution graph created by ArcMap.  For other applications, these can be very useful analytical tools.

If you are unfamiliar with the terminology Frequency Distribution, close the Statistics window, go to the Help menu > ArcGIS Desktop Help, and look up “Frequency Distribution” in the Index.
26. Close this window, and then close the Attributes of Cities table

27. Save It Now. [image: image60.png]


 If you do not wish to continue, from the File menu select Exit. 
Congratulations! You have completed Part C of the K-12 Quick Start lesson!

Extension Exercise – Hyperlinking 

Hyperlinking allows you to link resources such as pictures, video, documents, and web sites to features on your map. 

1. Open an Internet browser. Go to a search engine such as “http://www.google.ca” and use the search terms: “about Nunavut”. Many websites are suggested: we will use the Government of Nunavut site; this has “.gov” in the URL. Right click and copy the link location (URL) to the clipboard. Close your browser.

2. In ArcMap, select the Identify tool and click on Nunavut. This will bring up the Identify window. 

3. In the left portion of the window, there is the place name (“Nunavut”).  Right click on that name and select Add Hyperlink.

4. In the Add Hyperlink window choose Link to a URL. When you do this, the lower text box becomes active.

5. Right click in the URL box and past the link to the website.

6. Close the Identify window and you have successfully created a Hyperlink to a website.

Testing Your Link:

1. In your map view, click on the Hyperlink tool [image: image61.jpg]


 located on the toolbar. 

2. To use this tool, simply hover over the point (place) for which you added the link and when the lightning bolt turns black, click the point to activate the link. This will open the Nunavut page in your web browser. 

3. When you are finished viewing the website, close your browser and return to ArcMap.

Hint: The shape for which you have created a link will be identified with dark blue. Point symbols would have a dark blue dot over them. In this case, when you activate the tool, Nunavut is outlined in blue.

Note: The other option (Link to a Document) will allow you to link directly to any file that your computer is configured to open. It could be a text document such as a Microsoft Word or Notepad. One of the most common uses is to link to an image file to illustrate the feature. 
Appendix A – The ArcMap GUI
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The Table of Contents (TOC)

The Table of Contents lists all the layers on the map and shows what the features in each layer represent. You can turn each layer on or off by checking and unchecking the check box next to the layer. When the layer is on, it draws on the map. The order of layers within the TOC is also important; the layers at the top draw on top of those below them. 

[image: image63.emf]

 

Layers

Geographic data are represented on a map as a layer. A layer might represent a particular type of feature such as highways, lakes, or wildlife habitats, or it might represent a particular type of data such as a satellite image, a computer-aided design (CAD) drawing, or a terrain elevation surface in a TIN.

A layer doesn't store geographic data itself; instead, it references the data stored in coverages, shapefiles, rasters, and so on. Thus a layer always reflects the most up-to-date information in your database. If you don't have a layer, you can easily create one. For example, you might create several layers that highlight different aspects of your data and distribute them to others in your organization.

Even though you have access to a layer on disk, it won't draw on your map unless you also have access to the data source on which the layer is based.

Data Frames

Layers in the TOC can be further organized into data frames. A data frame simply groups, in a separate frame, the layers that you want to display together. You always get a data frame when you create a map; it's listed at the top of the TOC as "Layers", but you can change the name to something more meaningful.

	Toolbars
Toolbars can contain menus, buttons, tools, or edit boxes—different types of commands. Additionally, other toolbars are available to use when you are performing a particular task. Any toolbar can be docked at the top or bottom or to the left or right side of the ArcMap window. Alternatively, toolbars can float on the desktop while functioning as part of the application. When you dock a toolbar, it is moved and resized with the application's window. To prevent a toolbar from docking, hold down the Ctrl key while dragging it.
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Toolbar Click on the tool buttons to select a tool. This toolbar can be docked.





Menu Bar Click on menu titles to open then.





Table of Contents








Layer Name Right-click the Layer Name to bring up more options.





Map Area Your map appears here. 





Make sure to click right on the point. 





Menu Bar – contains ArcMap pull-down menus grouped by function type. (E.g. File» Exit)





Table of Contents 





Window Title Bar – Use to select a window and move windows around the screen





Tool Tips –Hold the mouse pointer over a Button or Tool to get its name.





Toolbar – Contains ArcMap tools. Click a tool and it becomes active (pushed in). Apply the tool inside a document to execute the function. (E.g. Zoom In)
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